20.7 Computer- As with other quantitative methods, the techniques of network analysis have
based solutions to been made available in computer software. While early applications did little
network problems more than take the tedium out of calculating the duration of the critical path and
| | | task start and finish dates
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which have similar or more extensive facilities and cost a great deal more to pur-
chase but Project for Windows (PfW) provides a good start in examining the basic
features of such software.

Assuming that the software has been installed on the computer and is ready for
use the first thing to do is get it running by using the mouse to click the PfW
icon. The opening screen will look something like that shown in Figure 20.18.
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Figure 20.18 The opening screen for Microsoft Project.

™ Dan't display this startup screen again.

-

As with most Microsoft software, tutorials and introductory options are avail-
able and it would benefit the new user to take the time to investigate these
sources of information before checking the ‘Do not show again’ box. What fol-
lows assumes that the user has some understanding of the preceding text on net-
works and has the skills to use keyboard and mouse to enter data into the
appropriate areas of the software.

A mouse click on ‘Start a New Project’ closes the Welcome inset and gives a
clear view of the Task Table and Gantt Chart Screen, Figure 20.19.

This screen has the standard features of most Microsoft Windows products — a
menu bar, icons for printing, etc., scroll bars for moving the viewing area but
with the addition of functions specific to project planning. The working area of
the screen is split vertically into a spreadsheet like table on the left and calen-
dar on the right. Most of what appears can be customized, although there are
some limits as to what can be done. The columns of the left-hand spreadsheet
area are already titled from a preset selection. Double clicking on a column head-
ing brings up a range of alternative column headings such as planned cost, %com-
pleted, etc. Some of these headings are linked to built in calculations such as
%completed, some to user-entered data on which the calculations are based, e.g.
duration and others are just information fields which have no effect on the opera-
tion of the software. Double clicking on the calendar headings allows the resolu-
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Figure 20.19 The Task Table and Gantt Chart Screen.

tion of the calendar to be changed to show hours, days, weeks, months or quar-
ters with appropriate subdivisions.

The calendar bar is also a first clue that this software is intended for use in
the real world. The dates shown on the calendar bar are the current and coming
days, weeks or months, the date having been picked up from the computer’s
date function. Saturday and Sunday are shown with grey vertical strips to show
that the software currently considers these to be non-working days.

This chapter commenced by looking at The Ressembler Group’s project to launch
a new type of picture frame. The data for this project is as shown in Table 20.8.
with the modification that the unique task identifiers have been changed to num-
bers rather than letters of the alphabet to suit the needs of Project for Windows.

Table 20.8 Ressembler’s new product launch

Activity  Activity Preceding Duration

label number Description activities (days) Resources

A 1 Decide test market area - 1 1 Staff

B 2 Agree marketing - 2 1 Staff
strategy

C 3 Agree production - 3 1 Staff
specification

D 4 Decide brand name B 1 1 Staff

E 5 Prepare advertising plan A 2 1 Staff

F 6 Agree advertising E 3 1 Staff
package

G 7 Design packaging D 2 2 Staff

H 8 Production of test batch  C 5 1 Staff

| 9 Package and distribute G, H 10 1 Staff

J 10 Monitor media support F, D 3 1 Staff
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Before making any entries into the software it is worth checking the default
settings. Selecting the Tools Menu and then Options from that menu results in
the display of a tabbed inset which allows various software settings to be chan-
ged. Selection of the Schedule Tab provides access to settings which govern the
way in which tasks are scheduled. This tab includes a field titled ‘Default Dura-
tion Type’ which should show ‘Fixed Duration’. If ‘Resource Driven’ is showing
clicking on the down arrow next to the field box will allow the setting to be
altered to ‘Fixed Duration’. Tasks which are resource driven will have their dura-
tion changed if additional staff are assigned to them. As we will later be assigning
two staff to carry out the task of ‘designing the packaging’ (Activity 7) and in our
example the duration is fixed at 2 days we do not want the software to inad-
vertently reduce the duration to 1 day. This feature will be discussed further
when we look at resource levelling.

While the ‘Options’ inset is still open click the ‘Calculation’ tab and confirm
that ‘Automatic’ is selected. Clicking OK closes the inset and allows us to pro-
gress to entering tasks, precedence and durations.

Figure 20.20 shows the Task Table and Gantt Chart View with the 10 task
descriptions entered. All that has been keyed in are the 10 task descriptions in
the Task Names column. Everything else has been created by the software. Enter-
ing ‘Decide test market area’ in row 1 automatically gives that task the unique
identifier of ‘1’. As with other table structures you can drag the contents of rows
to new locations but the significance of the row number as a unique task identi-
filer means that the logic of the network is also changed so you need to be careful
when using this feature. If you choose to insert rows between existing entries all
existing row references will be properly changed to reflect the new identifiers.

Continuing with Figure 20.20, the software has assumed a default duration of
1 day and that all tasks can start immediately. The start and finish dates shown
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Figure 20.20 The Gantt Chart View with Task Descriptions Entered.
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are the results of a network calculation based on those assumptions. On the
right-hand side of the screen blue activity bars have appeared for each task syn-
chronized to the assumed start date — this display is a Gantt chart.

A few manual changes have also been made to the screen display. The print
size has been increased to make it more readable and the vertical split has been
dragged to the right to accommodate the larger print. Dragging the centre split
left or right allows the user to see more or less of the Gantt chart. Each side of
the split has its own scroll controls at the bottom so you can scroll the table and
the Gantt chart to see whichever columns or dates you wish. The vertical scroll
bar works on both sides of the split at the same time so that the task names stay
in line with their related Gantt chart bars.

Figure 20.21 shows the effect of entering the predecessors — the logic of the
network.
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Figure 20.21 The Gantt Chart View with Predecessors Entered.

Tasks 1-3 have no predecessors and the predecessor column is left blank.
Task 4 is dependent on task 2, so 2 is entered in the predecessor column. When
the entry is complete the return key must be pressed to move on to the next cell
or the tick checked on the line above the column titles. Mouse clicking on the
next line merely adds that row number to the dependency - this can be annoying
if you are used to selecting cells in a spreadsheet by clicking on them. Tasks 9
and 10 do have multiple predecessors. Once the first dependency has been
keyed in, any others can be added by mouse clicking the appropriate row. The
entry is ended for that cell by pressing return.

As the network logic is keyed in the appropriate links will appear on the Gantt
chart and the task bars will move to reflect the Earliest Start Date permitted by
preceding task durations and the logic. Figure 20.21 illustrates this, and also
shows that the software is recognizing the weekend as non-working time and not
scheduling work for Saturday and Sunday.

The next set of information to be entered is the duration of tasks.
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Figure 20.22 The Gantt Chart View with Durations Entered.

Figure 20.22 shows the results of entering the specified task durations.
The first task has been given a duration of 1d, 1 day, and as the present start day
of the project is Friday it finishes before the weekend. The second task has a
duration of 2 days but the Gantt chart bar is 4 days in length to allow for the
task spanning the weekend. Allowing a task to be split by a non-working period
normally presents no problems but occasionally can be difficult. If, for example,
this task of Agreeing Marketing, involved marketing consultants travelling to visit
the company we might prefer the 2 days to be sequential so we do not have to
pay excessive travelling costs or hotel bills for the consultants staying over the
weekend. In this example we could either change the project start date to the
Monday or we could move this task to start on Monday. Moving the task can be
achieved by clicking on the task bar, holding the right mouse button down and
moving the task so that it starts on Monday. The size of the bar and the dates in
the table will automatically change to reflect the change. There is however a
hidden consequence of moving the bars or changing the calculated dates. Double
clicking on row 1 will result in the display of the ‘Task Information’ inset. Click-
ing the ‘Advanced’ tab shows a selection of fields related to the task one of
which is identified as ‘Type’. This should be showing the default setting of ‘as
soon as possible’. This means that any change of logic, addition of new tasks,
resource levelling, etc. will always have the effect of scheduling this task at it’s
earliest possible start date. In contrast double clicking on a task which has been
manually moved from its calculated position and then accessing the ‘Advanced’
tab will show that type has changed to ‘Start no earlier than’ or some other con-
strained type. Any subsequent rescheduling will now treat the manually posi-
tioned task as having a fixed earliest start date.

Entering the task descriptions, their precedence and their durations has
resulted in the software presenting a project plan in the form of a Gantt chart
and a table of task start and finish dates. These indicate that the project com-
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mences on 25 August and that the last task is completed on the 19 September; a
total of 26 calendar days. In this period there are four weekends each with two
non-working days giving a total of 8 days lost to the project. The number of work-
ing days spent on the project is 26 minus 8, a total of 18 working days. This is
the same as shown in Figure 20.11, the resource graph for the project drawn to
carry out manual levelling.

The project can be viewed as a network diagram by selecting PERT chart from
the View Menu. Figure 20.23 shows the screen displaying the PERT chart for the
Ressembler project.
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Figure 20.23 The PERT Chart View.

What is displayed is actually a precedence diagram not a PERT chart. A feature
of PERT is the use of optimistic, expected and pessimistic durations for tasks,
allowing a probability calculation to be made for the project finish date. As PfW
itself will only allow one value for task duration it cannot produce a PERT chart.

The precedence diagram provided by this software, and most other software,
differs significantly in appearance from the activity-on-arrow (AOA) diagrams used
to manually draw a network but performs exactly the same function. The boxes
represent the tasks and show their description, unique identifier, duration, start
date and finish date. What is displayed in the task box can be changed using Box
Styles from the Format Menu. The arrows serve only to show the linking logic
between tasks but allow linkages not available with AOA diagrams. The AOA dia-
grams drawn in the preceding text are all based on finish—start links, the preced-
ing task must be finished before its successor can start. However, consider a
project such as painting a large bridge. The primer coat may be ready for top coat
after a day of drying, but it could take a week to completely primer coat the
structure. The best logical link between these activities would be ‘start to start
with a 1-day lag’, i.e. whenever primer coating starts, top coating follows a day
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later. Double clicking on an arrow in the PERT view brings up an inset that
allows the linkage type to be changed and lags or leads to be entered.

The lower three activity boxes in Figure 20.23 have a slightly heavier border
and are red on screen to indicate that they are the critical path; 3, 8, 9.

The screen as shown has been rearranged from the way in which it was first
presented by the computer by dragging the boxes into positions on the screen
which give the clearest representation of the network. As computers have no
sense of the aesthetics of diagrams, the PERT chart first presented can be very
messy and difficult for the human eye to sort out. Re-arranging the diagram has
no effect on the logic of the network. Tasks can however be added or removed
and links changed in the PERT view if the user wishes to do so and is happy
working in this graphical environment. Such changes are reflected in changes to
the data in the Gantt chart and task table.

Returning to the Gantt Chart View, sliding the vertical screen split to the left
reveals more columns, including one headed ‘Resource Names’. If this column is
not present insert a new column and select the ‘Resource Name’ field to head it.
Keying in ‘Staff’ in the Resource Name cell of the first task automatically creates
a resource named ‘Staff’. Resources can be individuals (Fred Bloggs), groups of
workers (painters) or physical equipment (crane, test bed, etc.). The example
project uses only one resource type ‘staff’ for all tasks so the entry in the first
cell can be copied and pasted to all other Resource cells. Task 7 however uses
two staff where the other tasks only require one. Double clicking on row 7
brings up the ‘Task Information’ inset as shown in Figure 20.24.
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Figure 20.24 Adding Resource Usage.

=

Selecting the Resources Tab displays several fields and a Resource Table for
this specific task. Staff is shown in the first row of the inset table as we have
already entered this in the column — other resources could be added in the other
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rows so that the task employs multiple resources. Selecting the ‘1.00’ in the
units column next to staff and keying in ‘2’ increases the requirement of staff for
this task to the set level. In this screen shot ‘Duration Type’ is set as Resource
Driven not Fixed Duration and the consequent halving of task duration can be
seen in row 7. Changing to Fixed Duration returns the task duration to 2 days.
The number of units allocated is shown in brackets in the Resource Names
column.

While the software has automatically created a resource named ‘staff’ it knows
nothing about this resource and will only have given it the default values. Figure
20.25 shows the Resource Sheet selected from the View menu.
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Figure 20.25 The Resource Table.

The entry on the resource sheet shown in Figure 20.25 has been amended to
show max. units as 3, the number of staff available for this project, their standard
rate as £10.00 per hour, overtime rate as £15.00 per hour and a cost/use of
£20.00. Pro-rated indicates that costs will accrue on an hourly basis so that if 2
hours of actual work are reported then £20 will be added to actual costs. The
resource calendar is shown as standard, which means that this resource is taken
to be available during all normal working days and hours. An individual calendar
can be created for each resource which reflects availability for longer working
hours or weekend working and shows any annual holiday periods.

In the real world a company such as Ressemblers would probably have already
created a full resource table for the year showing all its staff, their working hours
and holidays. As PfW can handle multiple projects this table would be available to
all projects being undertaken by the company and scheduling would reflect use
of resources on other projects. Such complexity is beyond the intended scope of
this text.
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Having entered detailed values for the ‘staff’ resource it is now sensible to look
at the use of that resource. Figure 20.26 shows the view obtained by selecting
‘Resource Graph’ from the View menu.
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Figure 20.26 The Staff Resource Graph.

The graph shows the level of resource and the times at which it is required by
the current plan. At present four staff are required for 2 days in the second week
of the project. This exceeds the total number of staff available and this excess
demand is shown in red on the screen. In fact, the staff resource was shown in
red in the Resource Sheet which also indicated the existence of an overload.

Several remedies are possible. The total number of staff available could be
increased, the working calendar could be modified to allow weekend or overtime
working or the tasks could be adjusted from their earliest start dates to make
best use of the existing resource. In extreme cases the logic of the project could
also be reviewed.

The Tools menu allows the user to both carry out resource levelling, i.e. make
best use of existing resources, and remove its effects. The later is important
since if the results of resource levelling are an unacceptable increase in project
duration it may be necessary to go back to the unlevelled schedule, implement
some of the other remedies for overload and then Resource Level again. Figure
20.27 shows the screen with the Resource Levelling inset displayed.

Clicking on ‘Level Now’ invokes the levelling function. This is best left as a
manual choice as ‘Automatic’ can have some unanticipated effects during the
planning stage of a project. Figure 20.27 shows the data after it has been
levelled, the inset has been recalled for the sake of the illustrative figure.

The task table shows that task 6 ‘Agree Advertising’ has been moved later by 2
days to remove the overload. As a consequence this activity now spans a weekend.
Activity 10 has also moved to a later start time as it is dependent on activity 6.

Figure 20.28 shows the revised graph for the staff resource after levelling with
resource usage held within the maximum of three staff.
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Figure 20.28 The Staff Resource Graph after Levelling.

Figure 20.29 shows the project summary for the stage in planning currently
reached. This inset is obtained from the File Menu, Summary Info., Statistics.
More detailed reports can be produced but as printouts rather than screen dis-
plays.

The statistics inset gives a current (planned) duration of 18 (working) days for
the project, a start date of 25 August and finish date of 19 September. Based on



| 508

20.7.8 Concluding
comments on the use

of project
management
software

Modelling

72 Microsoft Project - RESSAS.MPP 8] x]

gl File Edit Yew Inset Fomat Tools ‘window Help

i=|

nEFEREREEEEEEEEE RS EESENE]
[

. - | g 00 [ 28 Aug 00 | 04Sep 00 | 11Sep 00 | 18Sc«
Task Name Duration Start | Finish Pr: ‘Resource IFFE |S!M!TMT|F E |SM|T|.’V|T|F|S\SMT|.’\I1T\F\S\S i W_
- 18 ff 7 HEH i H
i Project Statistics for RESSAS.MPP
2 |Agres File Mame: RESS5AS MPP
marketmg Directory: C:ABOOK\
| Template: | Help |
3 |Agree e [[Hew |
production | Created: 25/08/00 Revision Number: 1
4 |Decide bra| LastSaved:  25/08/00 Last Saved By: J. Alesander
name Last Printed: Last Saved Size: 36 kByles
5 Prepare Statistics:
—— advertising | pe,cent Complete:  Duration: 0% Work: 0%
Agree_ Start Finish
| |advertising| [Eomen 25/08/00 19,09/00
T |Design Baseline Hd Hid,
packading | | Actual HA Ha
8 |Production | | Vaiance o i
— | test batch Duration Wk
Package al Miyen 18d 272h
distribute | ["Baseine 0 th
10 (honitor me| [Actual [if] th
support Remairing 18d 272h £2,540.00
1
12
-
K 3 K o)
| For Help on dialog box options, press F1 ‘ \ MUK

Figure 20.29 The Project Summary.

the costs entered for using staff the overall cost of the project is £2940 for 272
hours of work.

When planning is judged to be complete and accepted by the participants the
project can be saved with a ‘Baseline’ which effectively freezes the plan. During
execution of the project problems encountered may require some replanning of
remaining activities which will change the ‘current’ plan. Having a frozen baseline
always allows actual performance to be compared with the original as well as the
current plan.

As the work progresses returns on actual work done can be entered at regular
intervals so that the project can be effectively managed.

The coverage of PfW as an example of project management software is limited by
the space available in this book. The software is rich in features to support realis-
tic planning and monitoring of real-world projects. Learning to use such software
for the occasional small project is probably not worth the effort but doing so for
larger projects and situations where an organization manages its workload as a
series of projects would be of great benefit.

In such larger projects uncertainty needs to be taken into account and can be
dealt with by add-on software such as (@Risk for Project. This piece of software
allows probability distributions to be associated with both task durations and costs.
The add-on uses Microsoft Excel to run multiple Monte Carlo trials with the data
and then feeds back the results to PfW so that the most likely project durations and
cost are displayed. The effects on the plan of uncertainty can then be evaluated and
manual interventions made to address uncertainty and minimize cost and duration.

Computer-based solution of network problems is now a large and mature sub-
section of quantitative methods which allows extensive manual and automatic
manipulation of the basic data using experienced qualitative judgement to arrive
at manageable project plans.



